
 NavRules is a training aid for teaching the various light patterns, dayshapes, and sound 
signals listed in the 72 COLREGS.    These lights, dayshapes, and sound signals form the 
foundation of an internationally recognized method of recognizing vessels and obstructions 
in various degrees of visibility.
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Copyright/License/Warrantee
NavRules, including all program, data, and help files is    Copyright © 1994-1995 
by Bruce A. Pennypacker.    All rights pertaining to Navrules and the associated 
files are reserved by the author.

Disclaimer
This program is supplied "as is".    No warrantee, implied or explicit, is made with regard to 
this program or it's fitness.    Under no circumstances will the author be held liable for any 
damages that may be incurred by using this program, even if the author has been notified in
advance of
the possibilities of such damages.    In some states there are limitations to the disclaimer of 
an implicit warrantee.    If, for any reason, the author is found liable for damages as a result 
of use of this program, such damages will be limited to the amount paid for this program, 
which,
according to the distribution authorized by the author, is $20 for registered users.

Distribution
This version of NavRules may be freely distributed as long as the following conditions are 
met:

No representations of ownership are made by anybody other than the author.

No changes are made to any of the program, data, or help files.    No files are added 
or removed from the distribution files.

No charge is levied, excluding disk duplication and shipping, or modem connect 
charges.

All other rights are reserved by the author.

Distribution of this program does not imply an agreement to use it.    Any use of this program
requires registration with the author.
 



Dayshapes
One or more special geometric marks, such as a black diamond, that is hung aloft to indicate
the type, state, or occupation of a vessel.    A single ball, for example indicates a vessel at 
anchor.    Dayshapes, as the term indicates, are used only during daylight conditions.



Light Patterns
A collection of one or more red, green, white, or yellow lights displayed by a vessel or other 
object in the water.    The number, pattern, and color of the lights indicate the type or 
purpose of the vessel or object, and can also indicate the direction in which the vessel is 
traveling.



Sound Signals
A series of specific sound patterns created by whistles, bells and gongs.    Sound signals are 
used to warn vessels of different situations during times of restricted visibility as well as to 
indicate the intentions and actions of vessels maneuvering within close proximity of each 
other.



Requirements for running NavRules
NavRules will run on any PC running Microsoft Windows 3.1, Windows 95, or Windows NT.    A 
color monitor is needed for displaying the various light patterns, and a Windows compatible 
sound card is recommended for the sound signals.    If NavRules is run on a computer that 
does not contain a compatible sound card, the following message will be displayed when 
sound signals are selected:

See the section Playing sounds over the PC Speaker for details on having NavRules play 
sounds over the PCs internal speaker.



Playing sounds over the PC speaker
A Windows compatible sound card is not required for playing the sound signals that 
NavRules teaches.    If a sound card is not present then you will need to install a sound driver
that allows sounds to be played over your PCs internal speaker.

There are various commercial, shareware, and public domain drivers available that will let 
you play sounds over your PCs speaker.    The drivers that you use will depend on the 
environment that you are running under (Windows 3.1, Windows 95, or Windows NT).    These
types of drivers can be found on many BBSs, on-line services such as Compuserve and 
America Online, or the internet.



Configuration options 
Selecting the Options... choice from the File menu will display the following dialog box.    
Click on the different parts of the dialog box for detailed descriptions:



Font
Select the font that will be used to display all the NavRules text.    The color of the text can 
also be selected, and will be used to display the text in the upper left and right corners of 
the window when a light pattern is being shown.



Night Color
Select the color to use as a background when displaying light patterns and vessel 
silhouettes.    Black should not be used, otherwise the vessel silhouettes will not be visible.    
Any color that your computer is capable of displaying can be selected. The default night 
color is dark purple.



Fog Color
Select the color to use as a background when studying sound signals.    Some sound signals 
are used only during times of restricted visibility, so NavRules displays a screen that is gray 
by default to simulate fog.    Any color that your computer is capable of displaying can be 
selected.



Beep on Incorrect Choice
When this check box is selected, NavRules will generate a short beep when an incorrect 
choice is selected during a quiz.    

When an incorrect choice is made during a quiz, the text of the selected choice will always 
turn red.    Having NavRules beep is an optional method of indicating an incorrect choice.



Display Message on Incorrect Choice
When this check box is selected, NavRules will display the following message when an 
incorrect choice is selected during a quiz:

When an incorrect choice is made during a quiz, the text of the selected choice will always 
turn red.    The message that NavRules displays is an optional method of indicating an 
incorrect choice.



Automatically Play Sounds
Select this option to have NavRules automatically play sound signals when sound questions 
are displayed.    If this option is not selected then no sounds will be played until the Play 
Sound button on the toolbar is pressed.



Warn When Last Question is Reached
When this check box is selected, NavRules will display the following message when the last 
question has been reached:

This option allows you to backtrack and review questions, or ensure all questions have been 
answered before ending a quiz.    If this option is not checked then NavRules will return 
immediately to the main screen after the last question has been reached.    



Top of Window
Shows the toolbar at the top of the NavRules window, immediately below the menu bar.



Bottom of Window
Shows the toolbar at the bottom of the NavRules window.



Hide Toolbar
Hides the toolbar.    The toolbar choices can still be accessed using the keyboard by pressing 
the characters underlined on the toolbar buttons.



OK
After all options have been selected, click on the OK button to permanently save the 
changes.    The changes will take effect immediately.



Cancel
Click on the Cancel button to abort any changes and return immediately to the main 
program.



Light Patterns - Learning and Quizzes
Light patterns in NavRules are displayed differently than sound signals and dayshapes.    
Light patterns are displayed twice, once showing only the lights, and once showing a 
silhouette of the vessel or object as well as the lights.    When selecting to either learn or quiz
light patterns, the following window will appear, allowing for various options to be selected.   
Click on an option with the mouse for a detailed description:

When learning light patterns, the orientation of the vessel will be displayed immediately 
below the displayed lights.    Below this the description of the current rule will be shown (see 
Learning vs. Quizzes for details).    When the rule is first displayed only the lights will be 
shown.    Clicking on the Next button will cause the silhouette of the vessel/object to be 
shown as well.    Clicking the Next button again will continue on to the next rule.

A quiz operates in a similar method.    At first only the lights are shown, and four possible 
descriptions of the rule are listed.    Once the correct rule is selected, a choice of viewing 
angles (if appropriate) is listed.    Selecting the correct viewing angle (starboard, port, bow, 
stern) will cause    the silhouette of the vessel/object to be shown.    If a viewing angle is not 
appropriate for the rule then the silhouette is immediately shown and the viewing angle is 
not asked.    At any point, the    Next or Previous buttons will take you to another question.



Sound Signals - Learning and Quizzes
Sound signals are divided into Inland and International Rules.    When choosing to learn 
sound signals or run a sound signal quiz, the following window will allow you to choose which
signals to use.    Click on an option for more detailed information: 

When both learning and running a sound quiz, a new button will appear on the NavRules 
toolbar.    This new button, Play Sound, provides a method of replaying a sound signal.    
Clicking on the button with the mouse or pressing the L or F2 key on the keyboard will cause
the entire sound signal to be replayed in full.

Sound signals are displayed very similarly whether being learned or quizzed.    Depending on
the sound signal, either a vessel silhouette or a phrase describing the current visibility 
conditions will be displayed.    The sound signal will then be played.    When learning sound 
signals a description of the rule will appear at the bottom of the screen.    Clicking on the 
Next or Previous buttons will cause the next rule to be played. (see Learning vs. Quizzes 
for details).    When performing a quiz a list of possible choices will appear.



Basic Light Patterns
Select this option to view basic light patterns.    Basic lights include those displayed by 
common power, sail, and row boats.    At least one of the Light Patterns options must be 
selected.



Advanced Light Patterns
Select this option to view advanced light patterns.    Advanced lights include those displayed 
by tug boats, barges, unusual vessels such as submarines, and all other not covered by the 
basic light patterns.    At least one of the Light Patterns options must be selected.



Inland    Rules
Select this option to display/play rules covered by the Inland Rules.    See 72 COLREGS for a 
description of Inland and International Rules.    At least one of the Rules options must be 
selected.



International Rules
Select this option to display/play rules covered by the International Rules.    See 72 COLREGS
for a description of Inland and International Rules.    At least one of the Rules options must 
be selected.



Sequential Order
Select this option to proceed through the selected rules in sequential order.    The order of 
the rules is essentially arbitrary, with the basic and more common rules coming first.



Random Order
Select this option to proceed through the selected rules in a random order.    All rules will be 
scrambled in a thoroughly random order before starting.



OK
Once the above options have been selected, click on OK to begin learning the rules or start 
the quiz.



Cancel
Click on the Cancel button to abort the quiz or learning of rules that has been selected.    
NavRules will return back to its previous state. 



Dayshapes - Learning and Quizzes
Most dayshapes are identical for both Inland and International Rules.    As a result, NavRules 
only allows you to select a sequential or random order when viewing dayshapes.    The 
following window will be displayed when dayshapes are selected.    Click on an option for 
more detailed information:

Dayshapes are the simplest set of rules for NavRules to display.    When learning the rules, a 
silhouette of the vessel with the appropriate dayshape is shown.    A description of the 
dayshape is displayed below the image. (see Learning vs. Quizzes for details).    Clicking on 
the Next or Previous buttons will continue on to another dayshape.    For a dayshape quiz, 
the silhouette will be displayed with four possible choices for the dayshape.



Learning vs. Quizzes
The behavior of NavRules varies slightly when learning a set of rules and taking a quiz.    
When learning a set of rules, each rule is displayed and/or played over the speakers one rule
at a time.    A description of the correct rule will be displayed at the bottom of the window.    
In some situations more than one description will be displayed.    For example, a single white 
light may be a vessel under 50 meters at anchor, a stern view of a power driven vessel, or a 
vessel propelled by oars.    When a single white light is displayed, all three of these 
descriptions are displayed.    Simply click on the Next or Previous buttons with the mouse 
or press N or P on the keyboard to view the next or previous rule.    If the rule is a sound 
signal the sound can be replayed by clicking on Play Sound or pressing L or F2 on the 
keyboard.

When taking a quiz, each rule is displayed and/or played over the speaker(s) one at a time.    
Four possible choices will be displayed for the current rule.    Simply click on the button 
associated with the correct choice, or press the letter A, B,C, or D on the keyboard.    If an 
incorrect choice is selected the text of that choice will turn red.    Depending on the selected 
options, incorrect choices may also cause the computer to beep and/or display a message 
indicating the choice was incorrect.    Once the correct choice has been selected the display 
is changed to show only the correct answer.    To continue on to another question click on the
Next or Previous buttons with the mouse or press N or P on the keyboard.

See Also
Light Patterns - Learning and Quizzes
Sound Signals - Learning and Quizzes
Dayshapes - Learning and Quizzes
 



About the Author
The author of NavRules is an instructor and crew member in the United States Coast Guard 
Auxiliary, Flotilla 1, Division 5, 1st Northern Region (5-1 1NR), actively teaching boating 
courses in the greater Boston area.    He is also a professional software engineer with over 
five years experience in programming Microsoft Windows.

The author can be reached via any of the following:

Internet: brucep@msn.com    (preferred)
brucep@stylus.com

Regular Mail: Bruce Pennypacker
18 Hancock St.
Winchester, MA 01890

Comments
Any comments, suggestions, bug reports, etc. will be gladly received if sent to one of the 
above addresses.



United States Coast Guard Auxiliary

In 1939, Title 14, USC was adopted as Public Law by Congress authorizing the United States 
Coast Guard to activate a non-military Coast Guard reserve.    This reserve was a civilian 
component of the Coast Guard providing support in promoting small boat safety.

In 1941 the Coast Guard Reserve was retitled by Congress to form the Coast Guard Auxiliary. 
The Coast Guard Auxiliary is a non-military civilian organization that functions under the 
direction of the Commandant of the Coast Guard.    There are several fundamental purposes 
to the Coast Guard Auxiliary which are stated as follows by the Act of Congress that 
established the organization:

To promote safety and effect rescues on and over the high seas and on the navigable 
waters.

To promote efficiency in the operation of motorboats and yachts.

To foster a wider knowledge of, and better compliance with, the laws, rules, and 
regulations governing the operation of motorboats and yachts.

To facilitate other operations of the Coast Guard.

In carrying out these purposes, the Coast Guard Auxiliary has four basic programs, or 
cornerstones.    The first cornerstone, public education, involves teaching various classes 
from water safety to advanced navigation.    The next cornerstone involves vessel 
examinations, where Auxiliarists are trained to examine vessels for all legal and safety 
requirements.    These vessel examinations are entirely voluntary and private between the 
examiner and vessel owner - no information regarding the examination is forwarded to any 
authorities.    All boat owners are strongly encouraged to have their boats examined by 
qualified examiners.    The next cornerstone is operations, which encompasses all activities 
on, and above, the water.    Safety patrols, Search and Rescue operations, airplane patrols, 
regatta and fireworks patrols are all examples of operations that the Coast Guard Auxiliary 
are involved in.    The Coast Guard Auxiliary works very closely with the Coast Guard in the 
field of operations.    The last cornerstone is fellowship.    Auxiliarists not only work together, 
but also enjoy many social activities together as well.

To find out more about the Coast Guard Auxiliary contact your local Coast Guard or Boating 
Safety office.    Many marinas, marine stores and yacht clubs also have information on 
contacting and joining the Coast Guard Auxiliary.
 



Registration Information

CompuServe users can register NavRules on-line.    Just GO SWREG.

Select Print Topic from the File menu to print out the below registration form, or select 
Copy from the Edit menu to copy the registration form to a word processor.    Registration 
entitles you to a copy of the latest version of NavRules and notification of future updates.

NavRules Registration
NavRules version 2.1 (c)

Name:       ______________________________________________________

Address:    __________________________________Apt. # _____________

City:       ______________________________________________________

State/Prov: __________________Zip___________Country_______________

Compuserve Address: ______________________________________________

Internet Address:   ______________________________________________

Are you a member of the Coast Guard, Coast Guard Auxiliary, or
Coast Guard Reserve?  If so, list flotilla, station, etc.:

__________________________________________________________________

Comments:

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

__________________________________________________________________

Disk format: _____ 3.5 _____ 5.25

Be sure to enclose $20 in US funds.

Send to: Bruce Pennypacker
18 Hancock Street
Winchester, MA 01890

 



Program History
15 May 1994 - Version 1.1
Initial Release

 6 June 1994 - Version 1.2
- Minor internal modifications
- Updated readme file
- Fixed minor problems in installation program

6 August 1994 - Version 2.0
- Added full online help, including text of all rules
- Added ability to view/quiz all rules at once
- Added    ability to review incorrect choices after a quiz
- Incorporated new installation program

22 August 1994 - Version 2.01
- Fixed minor problem with focus when using keyboard

17 September 1994 - Version 2.02
- Added missing optional light pattern for sailboats

5 September 1995 - Version 2.1
- Vastly improved user interface
- Added support for saving and loading quizzes 
- Redesigned help files
- Added NavView program
- Tested under Windows 3.x, Windows 95, and Windows NT
 




